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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider MTS Allstream and Avaya IP Office Release 9.1 and
Avaya Session Border Controller for Enterprise Release 6.3.

MTS Allstream SIP Trunk Service (MTS Allstream) provides PSTN access via a SIP trunk
between the enterprise and the MTS Allstream network as an alternative to legacy analog or
digital trunks. This approach generally results in lower cost for the enterprise.

MTS Allstream is a member of the Avaya DevConnect Service Provider program. Information
in these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between MTS Allstream and Avaya IP Office solution. In the sample configuration, the
Avaya IP Office solution consists of an Avaya IP Office 500v2 Release 9.1, Avaya embedded
Voicemail, Avaya Communicator for Windows (SIP), Avaya H.323, Avaya SIP, digital and analog
endpoints. The enterprise solution connects to the MTS Allstream network via the Avaya Session
Border Controller for Enterprise (Avaya SBCE).

The MTS Allstream referenced within these Application Notes is designed for business customers.
The service enables local and long distance PSTN calling via standards-based SIP trunks as an
alternative to legacy analog or digital trunks, without the need for additional TDM enterprise
gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to MTS Allstream via Avaya SBCE.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the MTS Allstream
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were exercised
during the interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP).

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, outbound toll-free,
operator assisted call, 411 and 911 services.

e Codec G.729A and G.711U.

e Caller number/ID presentation.
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Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

FAX using T.38 and G.711 pass-through.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Remote Worker (using Avaya Communicator for Windows (S1P)) which allows Avaya SIP
endpoints to connect directly to the public Internet as enterprise phones.

2.2. Test Results

Interoperability testing of MTS Allstream was completed with successful results for all test cases
with the exception of the limitation described below.

Blind Call Transfer to PSTN using Avaya 1140E SIP phone does not complete until
transferee picks up the call — Call scenario is when PSTN phone calls to Avaya 1140E SIP
phone, Avaya 1140E SIP phone answers the call and performs blind transfer to another
PSTN endpoint. The expected behavior of Avaya 1140E SIP phone is after transfer, the
phone should display “transfer completed”. But in this case, user presses “transfer” button,
answers question of “Consultative transfer with party ?”” with “No”, which implies the blind
transfer, as the transferee PSTN phone is ringing, the Avaya 1140E SIP phone should be
released and display “transfer successfully”. Instead, the Avaya 1140E SIP phone still
displays “transferring” and not released until the transferee PSTN phone answers the call.
The work around is to hang up the Avaya 1140E SIP phone. This is minor known limitation
on Avaya 1140E SIP phone. There is no user impact. Transfer is still completed with two-
way audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the MTS Allstream SIP Trunk Service, please contact customer service at
855-299-7050 or visit: http://www.allstream.com/support.
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to MTS Allstream through the public IP network. For confidentiality and privacy
purposes, actual public IP addresses used in this testing have been masked out and replaced with
fictitious IP addresses throughout the document.

The Avaya components used to create the simulated customer site including:
Avaya IP Office 500v2

Avaya Session Border Controller for Enterprise

Avaya embedded Voicemail for IP Office

Avaya 9600 Series IP Deskphones (H.323)

Avaya 11x0 Series IP Deskphones (SIP)

Avaya 1408 Digital phones

Avaya Analog phones

Avaya Communicator for Windows (SIP)

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VolP codecs. The LANZ2 port of Avaya IP Office is
connected to Avaya SBCE. A separate Windows XP PC runs Avaya IP Office Manager to configure
and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with MTS Allstream SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to MTS Allstream. The short code of 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to MTS Allstream. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls, MTS
Allstream sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as data firewall. A complete
discussion of the configuration of these devices is beyond the scope of these Application Notes.
However, it should be noted that SIP and RTP traffic between the service provider and the Avaya IP
Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office 500v2

9.1.0.0 Build437

Avaya IP Office DIG DCP*16 V2

9.1.0.0 Build437

Avaya IP Office Ext Card Phone 8

9.1.0.0 Build437

Avaya IP Office Manager

9.1.0.0 Build437

Avaya Micro Session Border Controller for
Enterprise

6.3.000-19-4338

Avaya 1140E IP Deskphone (SIP) 04.04.18.00
Avaya 9640G IP Deskphone (H323) S3.2
Avaya 9630 IP Deskphone (H323) S3.2
Avaya Communicator for Windows (SIP) 2.0.3.30
Avaya Digital Telephone (1408D) N/A
Avaya Symphony 2000 Analog Telephone N/A
HP Officejet 4500 (fax) N/A
MTS Allstream Components

Equipment Release
Genband S3 SBC 7.1.15.2
Genband CS2K Hybrid SoftSwitch CVvM17

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without

T.38 Fax Service.
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5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Avaya SBCE.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC
running the Avaya IP Office Manager application, select Start - Programs - IP Office >
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window, and log in with the appropriate credentials. A
management window will appear similar to the one shown in the next section. The appearance of the
IP Office Manager can be customized using the View menu. In the screens presented in this section,
the View menu was configured to show the Navigation pane on the left side, the Group pane in the
center, and the Details pane on the right side. These panes will be referenced throughout the Avaya
IP Office configuration. Proper licensing as well as standard feature configurations that are not
directly related to the interface with the service provider (such as the LAN interface to the enterprise
site) is assumed to be already in place.

5.1. LAN2 Settings

In the sample configuration, IPOffice_1 was used as the system name and the LAN2 port was used
to connect to Avaya SBCE. To access the LANZ settings, first navigate to IPOffice_1 - System (1)
in the Navigation and Group Panes and then navigate to the LAN2-> LAN Settings tab in the
Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office LAN port.
Set the IP Mask field to the mask used on the public network. All other parameters should be set
according to customer requirements. Click OK to submit the change.

=
IP Offices System ’ 7 POffice_1" v

ds e AAME | LAND| DN | Yocemel | Telepheny | Diectery Senes | Syiem Everts | SMTP | SMOR  Towswnsng | VOM | Codecs | Vel Secuerty | Comtast Comter
LAt Settings| yuB | Netwes Tepdogy

P Addrenz bl ) 2

ki\"‘?f_ll@ )GGrERa™s

The VolIP tab as shown in the screenshot below was configured with following settings.

e Check the H323 Gatekeeper Enable to allow Avaya IP Deskphones/Softphones using the
H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to MTS
Allstream.

e Check the SIP Registrar Enable to allow Avaya IP Deskphones/Softphones to register using
the SIP protocol.

e Input Domain Name as 10.10.98.14.
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e The Layer 4 Protocol use UDP with UDP Port as 5060, TCP with TCP Port as 5060, and
TLS with TLS Port as 5061.

e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

e Check Enable RTCP Monitoring on Port 5005.

o Verify the DiffServ Settings were kept as default for the Differentiated Services Code Point
(DSCP) parameters in the IP packet headers to support Quality of Services policies for both
signaling and media, the DSCP field is the value used for media and the SIG DSCP is the
value used for signaling.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

| 7 IPOffice_1* e - v

LSystem l LANL . DNS l Voicemail ] Telephony | Directory Services l System Events I SMTP i SMDR l Twinning l VCM ] Codecs l VolIP Security | Contact Center}

[ LAN Settings | Network Tt'.vpology‘i

| [V] H323 Gatekeeper Enable{

P

|| Auto-create Extn Auto-create User [7] H323 Remote Extn Enable
1720
[¥] SIP Trunks Enable
{¥| SIP Registrar Enable
["] Auto-create Extn/User [] SIP Remote Extn Enable
Domain Name 101098.14
[¥] uop UDP Port /5060 = Remote UDP Port (5060 £
Layer 4 Protocol [ TCp TCP Port 5060 % Remote TCP Port 5060 = =
V] TLS TLSPort 5061 = Remote TLS Port 5061
Challenge Expiry Time (secs) 10
RTP
Port Number Range
Minimum 49152 = Maximum 53246 &
Port Number Range (NAT)
Minimum 49152 = Maximum 53246 2

| 7] Enable RTCP Monitoring on Port 5005 |

RTCP collector IP address for phones 0 0 0 0
Keepalives
Scope [ Disabled v t 30
Enabled

DiffServ Settings
B8 5| DSCP(Hex) B8 5| Video DSCP(Hex) FC |2 DSCP Mask (Hex) 88 % SIG DSCP (Hex)
46 +| Dscp 46 i Video DSCP 63 > DSCP Mask 34 1| SIGDSCP
[ OK H Cancel ][ Help
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port.

e Set Public Port for UDP as 5060, TCP as 5060, and TLS as 5061.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

i i IPOffice_1* = v

| 7SyAstem ! LANL | [LAN2 i DNS I Voicemail l Trele;hrcglil E)irec‘ton)f Services I System Eventsii SM'I:Pi [ SMD;( j[rjl'winnin_g | VCM I é;!ecs l VoIP Securityrl Contact C?ter‘i

([ Lan Set?ngs ] VolP 7‘ Network Topology| |

Network Topology Discovery
STUN Server Address 192.168.10.13 STUN Port 3478
Firewall/NAT Type [ Open Internet A |
Binding Refresh Time (seconds) 60 v
Public IP Address 0 .10 . 9% 14 | RunSTUN Cancel
Public Port
UDP 5060
TCP 5060
TLS 5061

{”] Run STUN on startup

i oK H Cancel H Help J

In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with MTS
Allstream, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
Telephony = Telephony tab in the Details Pane. Choose the Companding Law typical for the
enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the service
provider across the SIP trunk. Set Hold Timeout (secs) to 1200. Click OK to submit the changes.

B IPOffice_1*

& ~ by v

‘ System | LANL I LAN2 ] DNS ] Voicemaili Telephony| ‘ Directory Services I System Events I SMTP | SMDR | Twinning I VCM I Codecs I VolP Security | Contact Center

Default Name Priority
Media Connection Preservation Disabled X

Login Code Complexity

[] Enforcement

Complexity

Telephony] | Park & Page | Tones & Music| Ring Tones [ SM | Call Log | TUI
Analogue Extensions Companding Law &
Switch Line
Default Outside Call Sequence 1Normal v]
Default Inside Call Sequence [Ring Typel V] M_'
Default Ring Back Sequence {Ring Type2 'l
i i X = ) A-Law ) A-Law Line
Restrict Analogue Extension Ringer Voltage i~
-
Dial Delay Time (secs) 4 055 Status
[¥] Auto Hold
Dial Delay Count 0 PR
L Dial By Name
Default No Answer Time (secs) 15
[¥] Show Account Code
Hold Timeout (secs) 1200 £
[7] Inhibit Off-Switch Forward/Transfer
Park Timeout (secs) 300
[7] Restrict Network Interconnect
Ring Delay (secs) 5
- Include location specific information
Call Priority Promotion Time (secs) |Disabled 5 B |
[ Drop External Only Impromptu Conference 3
Default Currency usb v

[7] Visually Differentiate External Call

["] Unsupervised Analog Trunk Disconnect Handling
& High Quality Conferencing

[¥] Digital/Analogue Auto Create User

[”] Directory Overrides Barring

[ 0K l l Cancel ] [ Help
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5.3. System Codec Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP Office default of 101.
Select codecs G.711 ULAW 64K, and G.729(a) 8K CS-ACELP that MTS Allstream supports.
Click OK to submit the changes.

i= IPOffice_1 o v
i System I LAN1 I LAN2 [ DNS 1 Voicemail ] Telephony l Directory Services I System Events l SMTP I SMDR | Twinning I VCM | [Codecs !VoIP Security | Contact Centeri
‘RFC2833 Default Payload 101 > ‘
Available Codecs Default Codec Selection
Unused Selected
[@] G711 ULAW 621 6.723.1 6K3 MP-MLQ 3> G.711 ULAW 64K
V] G711 ALAW 64} G.711 ALAW 64K G.729(a) 8K CS-ACELP
| G.722 64K

[V 6.729(a) 8K CS-ACELP
[V] 67231 6K3 MP-MLQ

| OK H Cancel H Help
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5.4. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller 1D parameter on the SIP Line form (shown in Section 5.5.2).

If Send original calling party information for Mobile Twinning on the Twinning tab is optioned,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the IPOffice_1 = System (1) - Twinning tab was unchecked. The value sent in the
SIP From header is determined by the setting of the Send Caller 1D parameter on the SIP
Line form.

= IPOffice_1 i v

}”S;stem I LAN1 I LANZ IDNS I VVc;ircemarilr %élep}hony i bi;edory 7Serr\.rlirces IVSVystemrErvents iSMT;’ |SMDR VCM IVCoare:s l \710717P”Secu}irty iréontact VCVenter‘;

| Send original calling party information for Mobile Twinning I

Calling party information for
Mobile Twinning
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and MTS Allstream
SIP Trunk service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.5.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.
e SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New = SIP Line. Then, follow the steps outlined in Section 5.5.2.
For the compliance test, SIP Line 17 was used as trunks for incoming and outgoing calls.
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5.5.1. Create SIP Line from Template.
1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF_MTSAlIstream_SIPTrunk.xml (for SIP Line 17). The file name is
important in locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK to submit the changes.

™ IP Office Manager Preferences l 2 I&J
i Preferences I Directories ] Discovery J [Vi5U3| Preferencesl j Security I Validation‘
! Icon Size ‘Small vl

7] Multiline Tabs

l (/| Enable Template Optionsl

[¥| Enable Template Creation

(1) ‘ oK l ! Cancel I l Help

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

' Asaya P Ofice Manoger IPOMCe T 75 1OAIT] drvenistmondminsmaor] =
Fie B Yeew Tocts|| Hep
» |
‘ | E sPlsenen CEEICIAR
Expart :"" SubTrpe: | oo Lane Trnsgpon| 5 LI VoiP | 3% Ter 9P Credontive| SP Advinced | Engloesing
SO Sevsce Uses Managasent :
By an Hewd Valdoion
MSH Cosfigusntion |
Impert Tamrpristen in Manages
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window
below will appear stating success (or failure). Then click OK to continue. If preferred, this
step may be skipped if the template file is copied directly to the IP Office template directory.

F

Y
Template Provisioning &J

. \ Successfully imported templates to IP Office Manager from
L CA\MSTAllstream - IPO\Template

oK |

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New SIP Trunk from Template.

1P Offices Line |E SIP Line - Line 20 o-3 X v -
R poowm Line Namber  Line Type e b Type || o e Tramment| 59 WS VP | 738 70 TR C T pdvanced Eng -
Opesatar (3) -1 PRE 24 (Wnvessall T3
ey New
() [ Phew 20 Trunk feoem Tempilets |
Cq
@ ia
§
& G
=
D
o BN
v
9w
-~ D |
L
[ B |
o A e

5. In the subsequent Template Type Selection pop-up window, check Display All and select
AF_MTSAIlIstream_SIPTrunk from the Service Provider pull-down menu as shown
below. These values correspond to parts of the file name
(AF_MTSAIlIstream_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the SIP trunk.

" Template Type Selection I = ‘%I
Locale United States (US English
Service Provider | AF_MTSAllstream_SIP Trunk v’ [¥] Display Al
[ Create new SIP Trunk ] l Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.5.2.
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5.5.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown).

On the SIP Line tab in the Details Pane, configure the parameters as shown below:

e Set ITSP Domain Name to the IP address of Avaya IP Office LAN2 port.

e Set URI Type to SIP.

e Check the In Service and Check OOS boxes.

e For Session Timers, set Refresh Method to Reinvite with Timer (seconds) to 1200.

e For Forwarding and Twinning, set Send Caller 1D to None.

e For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: MTS Allstream did not support the REFER for compliance testing.

e Default values may be used for all other parameters.

e Click OK to commit then press Ctrl + S to save.

| Line. _if SIP Line - Line 17 [ B I

Ling-..  Line Type IF Live] Tonrapent SP ORI Vol T38 Fuel 9 C W Adverinl| g

SyRem Detast

FIEN S A} [ 166D T8
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of Avaya SBCE internal interface
10.10.97.174 as shown in Figure 1.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060 which is the port number provided by MTS Allstream.

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the System (1) > LAN2

e The Calls Route via Registrar was unchecked. In this certification testing, MTS Allstream did

not support the dynamic Registration on the SIP Trunk.

Other parameters retain default values.

Click OK to commit then press Ctrl + S to save.

= SIP Line - Line 17 gf -9 | X | v|< |3

|SIP Line Transport]sip URI|VolP | T38 Fax|SIP Credentials|SIP Advanced| Engineering

ITSP Proxy Address 10.10.97.174

Network Configuration

Layer 4 Protocol lUDP v ’ Send Port 5060 =
Use Network Topology Info ‘ LAN 2 - ’ = Port {2060

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar [ |

Separate Registrar

[ oK H Cancel H Help
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting allows
calls on this line which SIP URI matches the number set in the SIP tab of any User as shown
in Section 5.7.

e Set Registration to 0: <None>as MTS Allstream does not require registration.

e Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

E SIP Line - Line 17
B Line]Transpo¢§|MiVolp | 738 Fax|SIP Credentials|SIP Advanced | Engineering
Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
Remove
Edit...
Edit Channel
Via 10.10.98.14 K
Local URI Use Internal Data - Cancel
Contact Use Internal Data -
Display Name Use Internal Data v
PAI -
Registration [0: <None> v
Incoming Group 17
Outgoing Group 17
Max Calls per Channel 20 =
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Select the Vol P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Selecting G.711 ULAW 64K, and
G.729(a) 8K CS —ACELP codecs causes Avaya IP Office to support these codecs, which are
sent by the MTS Allstream, in the Session Description Protocol (SDP) offer, in that order.

e Uncheck the VoIP Silence Suppression box.

e Check the Re-invite Supported box.

e Set Fax Transport Support to T38 Fallback from the pull-down menu. MTS Allstream
supports both Fax T.38 and Fax G.711 pass-through modes.

e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

7 SIP Line - Line 17 af - X[ vi<]>
iél?Line{Transpor;]SIP UFZIi ﬁ38 Fa;ISTPCredentials EIP Advanceidlgngineerinrgj
[[7] VolIP Silence Suppression|
[¥] Re-invite Supported
Codec Selection [Custom '] [7] Codec Lockdown
Unysed — Se[ecfed . Allow Direct Media Path
G.723.1 6K3 MP-MLQ S>3 G.711 ULAW 64K - " e I
G.711 ALAW 64K .729(2) 8K CS-ACELP orce direct media with phones
| PRACK/100rel Supported
[7] G711 Fax ECAN
<L
Fax Transport Support [TBS Fallback vJ
DTMF Support |RFc2833 v
Media Security ‘Disabled v
I OK l 1 Cancel ] [ Help
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5.6. Short Code

Define a short code to route outbound traffic on the SIP line to MTS Allstream. To create a short
code, select Short Code in the left Navigation Pane, then right-click in the Group Pane and select
New (Not shown). On the Short Code tab in the Details Pane, configure the parameters for the new
short code to be created. The screen below shows the details of the previously administered “9N;”
short code used in the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@10.10.97.174”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the IP address of Avaya SBCE
internal interface.

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2. This short code will use this line group when placing the outbound
call.

e Setthe Locale to United States (US English).

e Default values may be used for all other parameters.

e Click OK to submit the changes.

POfices Short Code |= 9N:: Dial ool X o
R 8OO Code Tebaphane Nunbe  Feware .- Sheet Code
Y e N
PO [ N'@NI0FTIM"  Dhal N
v PEENED 0 FNE Servace Diw
® E Telephone Numbe e
B v -
B G "
; : Uried States (U5 Engla,
- el
en » (%) ek
o .
9 Fa
o>
L
Wl . mod 7“)
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following

parameters:

e For Code field, enter FNE feature code as FNEQO for dial tone.

e Set Feature to FNE Service.

e Set Telephone Number to 00.

e SetLine Group ID to 0.

e Setthe Locale to United States (US English).

e Default values may be used for other parameters.
e Click OK to submit the changes.

SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved.
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 1257. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 1257. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by MTS Allstream. The SIP Display Name (Alias) parameter
can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

User E 1267: 1287 oA X ¢

Foowsrdng  Dalls | Youe Recording | Buon Pragiammng | Menu Programmng |- Moty | Gioup Menberthg | Armoencements | % | Pagomal 1

s 1258 SP Nare
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One of the H.323 IP Deskphones at the enterprise site uses the Mobile Twinning feature. The
following screen shows the Mobility tab for User 1257. The Mobility Features and Mobile
Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to
dial to reach the twinned mobile telephone, in this case 91613XXX5205. Check Mobile Call
Control to allow incoming calls from mobility extension to access FNEOO (see Section 5.6). Other

options can be set according to customer requirements.

7

1257: 12567°

& -9 X v

Forwarding l Dial In I Voice Recording | Button Programming l Menu Programming | [Mobility [ Group Membership | Announcements I SIP [ Personal [+ [+

[7] Internal Twinning

<None>

Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

[¥] Mobili

Twinngd quile Number 91612)00(5205
(including dial access code)

Twinning Time Profile <None>

Mobile Dial Delay (secs) 2

-~

Mobile Answer Guard (secs) 0

[T] Hunt group calls eligible for mobile twinning
[”] Forwarded calls eligible for mobile twinning
[7] Twin When Logged Out

[7] one-X Mobile Client

[[Z] Mobile Call Control

[¥] Mobile Callback
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5.8. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (Not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2.

e Set the Incoming Number to the incoming DID number on which this route should match.

e Default values can be used for all other fields.

IP Offices | incoming Call Routs |E 17 B4TXXX1267 N

e Grpup 0 Incemang Mumber  Detnation Gandard

Vorce Zecorbg | Destnaton

Searwr Capabiny Ay Voxe -

Linve Groug [T

Locale Unatad States (US bngiehy -

1-lew -

l."llll?- iﬁor Q!u"?

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 647XXX1257 on line 17 are routed to
extension 1257.

|E 17 647XXX1267 o0 X v

Stangard | Youce Becoming |Uethnatons

Tiradrofie Dentimatioe Fallsack Ememmicn

» Detaut Vatuw AT A v
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For testing purpose, the incoming calls to DID number 647XXX1264 were configured to access
FNEOQO. The Destination was appropriately defined as FNEOQO as below screenshot:

IP Offices | incoming Call Route B 17 BATXXX1264 pred X o

we bisup D Incomng Number  Destnstion Staesdard  Vorce Aecontbry | (Destnrion

Tmebrotee Demtinat o0 Foltack ltenpon

3 Dtk Ve | $3T0 . 4 ‘

RAS I "
Incoming Call Route (5)]
WAN Pos

For testing purpose, the incoming calls to DID number 647XXX1264 were also configured to access
VoiceMail. The Destination was appropriately defined as VVoiceMail as below screenshot:

1P Offices | incoming Call Routs |E 17 647XXX1264 pred X v
Line brsup D Incemng Number  Destnstion Saestard  Viece Tecorbig Destnytan |
g:: Tmebrotes Destiruty on sltack Ltenpon
e 2 > Dtk Vatue || Vomatdas - =
S
~

L 0!(«'&} 24 . =

Incoming Cak foute |5]
WAN Do 12

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Configure Avaya Session Border Controller for Enterprise
This section describes the configuration of Avaya SBCE necessary for interoperability with the
Avaya IP Office and MTS Allstream SIP Trunk Service.

Avaya elements reside on the Private side and the MTS Allstream SIP Trunk Service resides on the
Public side of the network, as illustrated in Figure 1.

Note: The following section assumes that Avaya SBCE has been installed and that network
connectivity exists between the systems. For more information on Avaya SBCE, see Section 10 of
these Application Notes.

6.1. Log into the Avaya SBCE

Access the web interface by typing “https://x.x.x.x/sbc/” (where x.x.x.x is the management IP of the
Avaya SBCE).

Enter the Username and Password.

AVAYA =

'Passwordj |oooooooooooooo l

Logln |
Session Border Contro”er This system is restricted solely to authorized users for legitimate
= business purposes only. The actual or attempted unauthorized access,
for Enterprise

use: or modifications of this system is strictly prohibited. Unauthorized
users are subject to company disciplinary procedures and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The use of this system may be monitored and recorded for
administrative and security reasens. Anyone accessing this system
expressly consents to such menitoring and recerding, and is advised
that if it reveals possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials.

All users must comply with all corporate instructions regarding the
protection of information assets.

® 2011 - 2012 Avaya Inc. All rights reserved.
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The Dashboard main page will appear as shown below.

Session Border Controller for Enterprise AVAYA

Dashboard Dashboard
Administration

At DESUS twend kg mimeeirges s cxntey iy eosted o ome (o s sabeytenm | 1o g Sy ok sertied for sxtoridimd pronode of Srw mery Som iyt

Baciop/Restors pedatmunce degradatiag

RS I I

Global Parameters

S (4 System Time 0408 26 AM CS1 frush FMS
Globsl Profiles

PPM Services Version 6.3 030-19-4333 mSBCE
Doman Palcies Butd Date FriSep 2 00 1423 EDY 2004

TLS Management Utarse State oK

Devioe Specac Satings Aggregase Liceraing Overages 0

Posk Licemsing Cverage Coumt 0

Asma (past M haure) Incdanm (past 24 howrs)

Heona found Neow found

AdL

No netws found

To view system information that has been configured during installation, navigate to System
Management. A list of installed devices is shown in the right pane. In the compliance testing, a
single Device Name mSBCE was already added. To view the configuration of this device, click the
View as shown in the screenshot below.

Session Border Controller for Enterprise AVAYA
Dashbears System Management
Administrahon

Badop/'Restore .

| 1 =1 1
—_——— Duvices || Upilstes | | SSLVPN | | Lzensing |
[ System Management e | [{08n] % VPN Aoy
Global Parameters Devicn Name Managemmm Vansn
Glcbal Profiles oo
mSBCE 1019 0579 15 Commissioned
PPM Services % 4338

Doman Poloes

TLS Management

Device Specac Semngs
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The System Information screen shows General Configuration, Device Configuration, Network
Configuration, DNS Configuration and Management IP(s) information provided during
installation and corresponded to Figure 1. The Box Type was set to SIP and the Deployment Mode
was set to Proxy. Default values were used for all other fields.

System Information: mSBCE

General Configuration Device Configuration r License Allocation
Appliance Name mSBCE HA Mode No Standard Sessions 0
Requested: 0
Box Type SIP Two Bypass Mode No ;
Advanced Sessions 0
Deployment Mode ~ Proxy Hedueseid
Scopia Video Sessions g
Requested: 0
Encryption v
- Network Configuration
P Public IP Netmask Gateway Interface
10.10.97.174 10.10.97.174 255.255.255.192 10.10.97.129 Al
1010.98.106 10.10.98.106 255.255.255.224 1010.98.97 B1
~ DNS Configuration Management IP(s)
Primary DNS 10.10.98.60 [ [P 10.10.98.70|
Secondary DNS
DNS Location DMZ
DNS Client IP 1010.97.174
HV; Reviewed: Solution & Interoperability Test Lab Application Notes 30 of 73

SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSAIPO91SBCE6G3



6.2. Global Profiles

When selected, Global Profiles allow for configuration of parameters across all Avaya SBCE
appliances.

6.2.1. Configure Server Interworking - Avaya site

Server Interworking allows to configure and manage various SIP call server-specific capabilities
such as call hold, 180 handling, etc.

From the menu on the left-hand side, select Global Profiles = Server Interworking
e Select avaya-ru in Interworking Profiles.
e Click Clone.
e Enter Clone Name: IPO_14 and click Finish (not shown).

From the list of Interworking Profiles, click on IPO_14 to edit.
e Onthe General tab, set T.38 Support to Yes (if using Fax T.38) or No (if using Fax G.711
pass-through). Other options can be left at default.
e Onthe Timers, URI Manipulation, Header Manipulation and Advanced tabs, all options
can be left at default. Click Finish (not shown).
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The following screen shows that Avaya IP Office server interworking profile (named: IPO_14) was
added.

Session Border Controller for Enterprise AVAYA
Dashboarg Interworking Profiles: IPO_14
Adminstration [ Reonme ] Ciooa | Delote
BadopRestore 00 e AR S AL .
:
Systern Managamernt 2100
(= v v .
Global Parameters bmlal_"l hl] lﬁwumﬁf“‘ ‘[“ d
« [ Global Profiles [avaya :
-
Doman DoS OCS-Edgs-Server Hoid Seppeat NONE
Fingerprrn exce-com )
Server lmmrhlng' b g ”
Phone interworong S 101 Handing Neoa
Ideda Faorang s Iaiomay 12 Handiing Nooa
Routg OCE-FrontEnd-Sarver 183 Handing Menw
Server Configuration [P0 4] PR A
Topaology Hiding
Sxgnaling Manipulation UR! Geoup Neona
URI Growps Send Hokt No
PPM Services Jux Haneling No
Doman Poloes Oenesion Hander Suppont No
TLS Management
Datay ed SOP Handing No
Device Speciic Semngs
Ra-bwite Hasdling No
(736 Soppn
URI Scheme Sp
Via roacer Format RFCI261
Pevacy Ensbled No
User Name
PAszersed ldamy No
P-Praferros identy No ~
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6.2.2. Configure Server Interworking — MTS Allstream site

From the menu on the left-hand side, select Global Profiles - Server Interworking and click Add
as highlighted below.
e Enter Profile Name: SP4.
e On the General tab, set T.38 Support to Yes (if using Fax T.38) or No (if using Fax G.711
pass-through). Other options can be left at default.
e Onthe Timers, URI Manipulation, Header Manipulation and Advanced tabs, all options
can be left at default. Click Finish (not shown).
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The following screen shows that the MTS Allstream SIP Trunk Service interworking profile (named
SP4) was added.

Session Border Controller for Enterprise AVAYA

Dashboarns Interwerking Profiles SP4

Ade Ll I
dmnistration [ aas

Bacap'Restore - ¥
Irberwasckng Frofles CAck heer 1o add o desonpiom

System Management

2100 - BRI T y
Giobal Parametars (Geearai] | Tinsen || UR) Mandputation | | Header Manipatation || Advanced
« [ Gk Profies
15 e .~
Doman Des OCS-Edge-Sarver Hold Scppat NONE
Fingerprrd cacecem
i - o 103 Handin ’
[Server interworking| N >
Phene stenworking s 181 Hinding Nena
Media Farking Tpeia b 187 Handiing MNenw
Reutng v b anitcaton 183 Handling Nern
Server Configuranon e
it 2ot sbont LSPe] Rasr Handiing Ne
Topalogy Hiding 0. 14
Sunaleg Mampuation = URI Greup Nonw
URI Groups Send Holg No
PPM Services I Handling No
Dooain Foicies Ctvorsion Hosder Support No
TLS Managemant
% e X Detarged SOP Harefing No
Deyice Speciic Sethngs
Ro bwite Handing No
T 38 Seppont Yas )
URI Scheme =P
Via Haade Foma RFC3261
Privacy Enabiad No
Usar Name
P-Anseesed-idary No
P-Prafeerns-identity No v
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6.2.3. Configure URI Groups

The URI Group feature allows an administrator to create any number of logical URI groups that are
comprised of individual SIP subscribers located in that particular domain or group.

The following URI Group configuration is used for this specific testing in the DevConnect Lab
environment. The URI-Group named SP4 was used to match the “From” and “To” headers in a SIP
call dialog received from both Enterprise and MTS Allstream SIP Trunk Service. If there is a match,
the Avaya SBCE will apply the appropriate Routing profiles (see Section 6.2.6, 6.2.7), and Server
Flows (see Section 6.4.4) to route incoming and outgoing calls to the right destinations. In
production environment, there is not a requirement to define this URI.

From the menu on the left-hand side, select Global Profiles > URI Groups. Select Add as
highlighted below.
e Enter Group Name: SP4.
e Edit the URI Type: Regular Expression (not shown).
e Add URI: .*10\.10\.97\.174 (Avaya SBCE internal interface IP address), .*10\.10\.98\.106
(Avaya SBCE public interface IP address), .*10\.10\.98\.14 (Avaya IP Office LANZ interface
IP address), .*192\.168\.2\.12 (MTS Allstream Signaling Server IP address),
*nonymous\.invalid (Anonymous URI).
e Click Finish (not shown).
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6.2.4. Configure Server — Avaya IP Office

The Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. Together, these tabs allow one to configure and manage various SIP call server-specific
parameters such as UDP port assignment, IP Server type, heartbeat signaling parameters and some
advanced options.

From the menu on the left-hand side, select Global Profiles = Server Configuration - Add.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 350f 73
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSAIPO91SBCE63


mailto:*anonymous/.invalid

Enter Profile Name: IPO_14

On General tab, enter the following:
e Server Type: Select Call Server
e IP Address/FQDNs: 10.10.98.14 (Avaya IP Office LANZ interface IP Address)
e Port: 5060
e Transport: UDP
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On the Advanced tab:
e Select IPO_14 for Interworking Profile (Refer to Section 6.2.1).
e Click Finish (not shown).
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6.2.5. Configure Server — MTS Allstream
From the menu on the left-hand side, select Global Profiles = Server Configuration - Add.

Enter Profile Name: SP4.

On General tab, enter the following:

36 0f 73
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e Server Type: Select Trunk Server.

e IP Address/FQDN: 192.168.2.12 (MTS Allstream Signaling Server IP Address).
e Port: 5060.

e Transport: UDP.

e Click Finish (not shown).
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On the Advanced tab, enter the following:
e Interworking Profile: select SP4 (Refer to Section 6.2.2).
e Click Finish (not shown).
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6.2.6. Configure Routing — Avaya site

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing Profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information, and
packet transport types.
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From the menu on the left-hand side, select Global Profiles - Routing and click Add as
highlighted below.

Enter Profile Name: To_IPO_14 (not shown).
e URI Group: SP4 (Refer to Section 6.2.3).
Load Balancing: Priority.
Check Next Hop Priority.
Click Add button to add a Next-Hop Address
Priority/Weight: 1.
Server Configuration: IPO_14 (Refer to Section 6.2.4).
Next Hop Address: 10.10.98.14:5060 (UDP) (Avaya IP Office LANZ interface IP address).
Click Finish.
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6.2.7. Configure Routing — MTS Allstream site
The Routing Profile allows one to manage parameters related to routing SIP signaling messages.

From the menu on the left-hand side, select Global Profiles - Routing and click Add as
highlighted below.

Enter Profile Name: To_SP4 (not shown).
e URI Group: SP4 (Refer to Section 6.2.3).
e Load Balancing: Priority.
Check Next Hop Priority.
Click Add button to add a Next-Hop Address
Priority/Weight: 1.
Server Configuration: SP4 (Refer to Section 6.2.5).
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e Next Hop Address: 192.168.2.12:5060 (UDP) (MTS Allstream Signaling Server IP
address).
e Click Finish.
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6.2.8. Configure Topology Hiding — Avaya site

The Topology Hiding screen allows one to manage how various source, destination and routing
information in SIP and SDP message headers are substituted or changed to maintain the integrity of
the network. It hides the topology of the enterprise network from external networks.

From the menu on the left-hand side, select Global Profiles = Topology Hiding.

Select default under Topology Hiding Profiles, and click Clone. Enter Clone Name: To_IPO_14.
Click Finish (not shown).

Select To_IPO_14 under Topology Hiding Profiles, and click Edit.
e For the Header Request-Line,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- In the Overwrite Value column: 10.10.98.14.
e For the Header To,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- In the Overwrite Value column: 10.10.98.14.

e For the Header From,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- Inthe Overwrite Value column: 10.10.97.174.
Click Finish (not shown).
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6.2.9. Configure Topology Hiding — MTS Allstream site
From the menu on the left-hand side, select Global Profiles > Topology Hiding.

Select default under Topology Hiding Profiles, and click Clone. Enter Clone Name: To_SP4.
Click Finish (not shown).

Select To_SP4 under Topology Hiding Profiles, and click Edit.
e For the Header Request-Line,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- Inthe Overwrite Value column: 192.168.2.12.
e For the Header To,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- Inthe Overwrite Value column: 192.168.2.12.

e For the Header From,
- Inthe Criteria column select IP/Domain.
- Inthe Replace Action column select: Overwrite.
- Inthe Overwrite Value column: 10.10.98.106.
Click Finish (not shown).
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6.3. Domain Policies

The Domain Policies feature allows one to configure, apply, and manage various rule sets (policies)
to control unified communications based upon various criteria of communication sessions
originating from or terminating in the enterprise. These criteria can be used to trigger different
policies which will apply on call flows, change the behavior of the call, and make sure the call does
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not violate any of the policies. There are default policies available to use, or one can create a custom
domain policy.

6.3.1. Create Endpoint Policy Groups

The End Point Policy Group feature allows one to create Policy Sets and Policy Groups. A Policy
Set is an association of individual, SIP signaling-specific security policies (rule sets): application,
border, media, security, signaling, and ToD, each of which was created using the procedures
contained in the previous sections.) A Policy Group is comprised of one or more Policy Sets. The
purpose of Policy Sets and Policy Groups is to increasingly aggregate and simplify the application of
Avaya SBCE security features to very specific types of SIP signaling messages traversing through
the enterprise.

From the menu on the left-hand side, select Domain Policies - End Point Policy Groups.
e Select Add.
e Enter Group Name: IPO_14.
- Application Rule: default.
- Border Rule: default.
- Media Rule: default-low-med.
- Security Rule: default-med.
- Signaling Rule: default.
- Time of Day: default.
e Select Finish (not shown).
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From the menu on the left-hand side, select Domain Policies = End Point Policy Groups.
e Select Add.
e Enter Group Name: SP4.
- Application Rule: default.
- Border Rule: default.
- Media Rule: default-low-med.
- Security Rule: default-med.
- Signaling Rule: default.
- Time of Day: default.
e Select Finish (not shown).
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6.4. Device Specific Settings

The Device Specific Settings feature for SIP allows one to view aggregate system information, and
manage various device-specific parameters which determine how a particular device will function
when deployed in the network. Specifically, one has the ability to define and administer various
device-specific protection features such as Message Sequence Analysis (MSA) functionality, end-
point and session call flows and Network Management.

6.4.1. Manage Network Settings
From the menu on the left-hand side, select Device Specific Settings - Network Management.
e Select Networks tab and click Add button to add a network of inside interface as followings:
- Name: Network_Al.
- Default Gateway: 10.10.97.129.
- Subnet Mask: 255.255.255.192.
- Interface: Al (This is Avaya SBCE inside interface).
- Click Add button to add IP Address for inside interface: 10.10.97.174.
- Click Finish button to save the changes.
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|
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|

| Subnet Mask
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From the menu on the left-hand side, select Device Specific Settings - Network Management.

e Select Networks tab and click Add button to add a network of outside interface as
followings:
- Name: Network_B1.
- Default Gateway: 10.10.98.97.
- Subnet Mask: 255.255.255.224.
- Interface: B1 (This is Avaya SBCE outside interface).
- Click Add button to add IP Address for outside interface: 10.10.98.106.
- Click Finish button to save the changes.

From the menu on the left-hand side, select Device Specific Settings = Network Management.
e Select Interfaces tab
e Click on the Status of the physical interfaces being used and change them to Enabled state.
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6.4.2. Create Media Interfaces

Media Interfaces define the type of signaling on the ports. The default media port range on the

Avaya can be used for both inside and outside ports.

From the menu on the left-hand side, Device Specific Settings - Media Interface.

e Select Add button and enter the following:
- Name: InsideMedia

Port Range: 35000 - 40000
- Click Finish (not shown)

e Select Add
- Name: OutsideMedia

Media IP: 10.10.97.174 (Internal IP Address toward Avaya IP Office)

- Media IP: 10.10.98.106 (External IP Address toward MTS Allstream trunk)

- Port Range: 35000 - 40000
- Click Finish (not shown).
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6.4.3. Create Signaling Interfaces
Signaling Interfaces define the type of signaling on the ports.

From the menu on the left-hand side, select Device Specific Settings >

e Select Add button and enter the following:
- Name: InsideSIP

UDP Port: 5060
Click Finish (not shown).

From the menu on the left-hand side, select Device Specific Settings >

e Select Add button and enter the following:
- Name: OutsideSIP

Signaling Interface.

Signaling IP: 10.10.97.174 (Internal IP Address toward Avaya IP Office)

Signaling Interface.

- Signaling IP: 10.10.98.106 (External IP Address toward MTS Allstream trunk)

- UDP Port: 5060
- TCP Port: 5060
- Click Finish (not shown).

Note: For the internal interface, the Avaya SBCE was configured to listen for UDP on port 5060.
For the external interface, the Avaya SBCE was configured to listen for UDP or TCP on port 5060.
Since MTS Allstream uses UDP on port 5060, it would have been sufficient to simply configure the
Avaya SBCE for UDP.
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6.4.4. Configuration Server Flows
Server Flows allow to categorize trunk-side signaling and to apply a policy.

6.4.4.1 Create End Point Flows — MTS Allstream Flow
From the menu on the left-hand side, select Device Specific Settings = End Point Flows.
e Select the Server Flows tab
e Select Add, enter Flow Name: SP4 Flow.
- Server Configuration: SP4 (Refer to Section 6.2.5).
- URI Group: SP4 (Refer to Section 6.2.3).
- Transport: *
- Remote Subnet: *
- Received Interface: InsideSIP (Refer to Section 6.4.3).
- Signaling Interface: OutsideSIP (Refer to Section 6.4.3).
- Media Interface: OutsideMedia (Refer to Section 6.4.2).
- End Point Policy Group: SP4 (Refer to Section 6.3.1).
- Routing Profile: To_IPO_14 (Refer to Section 6.2.6).
- Topology Hiding Profile: To_SP4 (Refer to Section 6.2.9).
- Click Finish to submit the changes.
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6.4.4.2 Create End Point Flows — Avaya IP Office Flow
From the menu on the left-hand side, select Device Specific Settings - End Point Flows.

e Select the Server Flows tab
e Select Add, enter Flow Name: IPO Flow.
- Server Configuration: IPO_14 (Refer to Section 6.2.4).
- URI Group: SP4 (Refer to Section 6.2.3).
- Transport: *
- Remote Subnet: *
- Received Interface: OutsideSIP (Refer to Section 6.4.3).
- Signaling Interface: InsideSIP (Refer to Section 6.4.3).
- Media Interface: InsideMedia (Refer to Section 6.4.2).
- End Point Policy Group: IPO_14 (Refer to Section 6.3.1).
- Routing Profile: To_SP4 (Refer to Section 6.2.7).
- Topology Hiding Profile: To_IPO_14 (Refer to Section 6.2.8).
- Click Finish to submit the changes.
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7. MTS Allstream SIP Trunk Configuration

MTS Allstream is responsible for the configuration of MTS Allstream SIP Trunk Service. The
customer must provide the IP address used to reach the Avaya SBCE at the enterprise. MTS
Allstream will provide the customer the necessary information to configure the SIP connection
between Avaya IP Office and MTS Allstream. The provided information from MTS Allstream
includes:

e [P address and port number used for signaling or media through any security.

e DID numbers.

e MTS Allstream SIP Trunk Specification.
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8. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed 2 active calls at present time).
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e Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start - Programs = IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

1S Avayn P Office Systen States - POMKe 1 (3010616 - 500 V2 3100 build 437 [y

IP Office System Status

Sebect 4 b 10 duplay the alerss information

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Use a network sniffing tool e.g. Wireshark to monitor the SIP signaling between the
enterprise and MTS Allstream. The sniffer traces are captured at the public interface of the
Avaya SBCE.
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9. Conclusion

MTS Allstream passed compliance testing. These Application Notes describe the procedures
required to configure the SIP connection between Avaya IP Office/ Avaya SBCE and the MTS
Allstream as shown in Figure 1.

10. Additional References

Avaya IP Office R9.1

[1] 1P Office 9.1 Administering Avaya IP Office Platform with Manager, Release 9.1.0, Issue 10.03,
February 2015.

[2] Avaya IP Office™ Platform Documentation Catalog Release 9.1, Document number 16-604278
Issue 2, December 2014

[3] Avaya IP Office™ Platform 9.1. Deploying Avaya IP Office™ Platform IP500 V2, Document
number 15-601042 Issue 30g, 27 January 2015

[4] Avaya IP Office™ Platform Embedded Voicemail User Guide (IP Office Mode), Document
number 15-604067 Issue 15a, 16 January 2015

Avaya Session Border Controller for Enterprise

[5] Avaya Session Border Controller for Enterprise Overview and Specification, Release 6.3, Issue
3, October 2014

[6] Administering Avaya Session Border Controller for Enterprise, Release 6.2, Issue 2, January
2014

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmI&TEMPLATE=pdf feed template.html

Product documentation for MTS Allstream SIP Trunk may be found at:
http://www.allstream.com/support.
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11. Appendix - Remote Worker Configuration via Avaya SBCE

This section describes the process for connecting select remote Avaya SIP endpoints on the public
Internet to Avaya IP Office on the private enterprise network via the Avaya SBCE. The provisioning
builds on the reference configuration described in previous sections of this document.

For more information, refer to Section 10 of reference [1].

Note — This Remote Worker configuration is based on provisioning the Avaya SBCE. It is not to be
confused with “native” Avaya IP Office Remote Worker configurations.

In the configuration for the compliance test, Avaya Communicator for Windows (SIP mode) was
used as the Remote Worker SIP endpoint.

The reference configuration for the compliance test, including the Remote Worker endpoint, is
shown in Figure 1 in Section 3. Internet access by the Remote Worker endpoint is through a
Router/NAT/Firewall/Default Gateway provided by the Bell Canada Internet Service located
between the Remote Worker private LAN and the public Internet.

Provisioning of the Bell Canada router is beyond the scope of this document.
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11.1. Provisioning Avaya SBCE for Remote Worker

Provisioning of the Avaya SBCE to support Avaya IP Office SIP connection to the service provider
is described in Section 6. The following sections build on that provisioning.

11.1.1. Network Management

This section shows the Network Management configuration of the Avaya SBCE to support Remote
Worker. For this purpose, the Avaya SBCE is configured with a second outside IP address assigned
to physical interface B1, and a second inside IP address assigned to physical interface Al.

The following IP addresses were used on the Avaya SBCE in the configuration used for the
compliance test:

10.10.97.174 is the inside IP address previously provisioned for SIP Trunking with the service
provider (see Section 6.4.1).

10.10.97.173 is the new inside IP address for Remote Worker.

10.10.98.106 is the outside IP address previously provisioned for SIP Trunking with the service
provider (see Section 6.4.1).

10.10.98.102 is the new outside IP address for Remote Worker.

On the Networks tab, select Add to create an entry for 10.10.97.173 on interface Al, then select
Save.
On the Networks tab, select Add to create an entry for 10.10.98.102 on interface B1, then select
Save.

Session Border Controller for Enterprise AVAYA
Global Parameters Network Management: mSBCE
Global Profiles
PPM Services .
Domain Policies Intordaces | ”Ne“"’o'ks ||
TLS Management [ Add |
“ Device Specific Settings Name Gateway Subnet Mask Interface IP Address
Network
Management Network A1 10.10.97.129 265255255192 A1 O AL Edit Delete
Media Interface 10.10.98.1
Signaling Intesface Network B1 10.10.98.97 255265265224 B1 EIRIETE 02.] Edit Delete
End Point Flows i
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11.1.2. Signaling Interfaces

Two new Signaling interfaces were created for the inside and outside IP interfaces used for Remote
Worker SIP traffic. Interface OutsideSIPRW supports TLS, while interface InsideSIPRW supports
TCP.

From Device Specific Settings on the left-hand menu, select Signaling Interface. Click on the Add
button to create Signaling Interface OutsideSIPRW.

e Signaling IP =10.10.98.102.

e TLS Port=5061.

e Select TLS Profile as AvayaSBCServer from the drop down menu.

From Device Specific Settings on the left-hand menu, select Signaling Interface. Click on the Add
button to create Signaling Interface InsideSIPRW.
e Signaling IP =10.10.97.173.

e TCP Port =5060.

Setlings ~  Help ~

Dashboarg Signaling Interface; mSBCE
Adminastration
Bacup/Restore
Signaiing lmerface ||
System Managament £ = -
D e mSBCE
Gobal Parameters Wstbrying or cheletyin i existeyy egraring vk edare Al e v uppsicarior deel s bedone feking tefinet Aqpdorion festorty oy b
Globa! Profiles FAR O Dot TiaSam A et
PPM Servces =
Dom Pobcies L
T TGP Pot DS Pt 115 Pant 115 Proie
LS Manaosame
. ki InaideSIF 10.10.97 174 - 080 - Nane
| Device Speciic Settngs
. P CutsizeSIiP 10 10 99 e S060 060 - Noos
Network Management
Media intoriace InskdeSIPRW 10.10 .97 173 S50 o
Signaling Interface | QuisicaSIFRW 1010 95 02 5061 Ay aSEC Sarver

End Point Flows

Signaling Interface InsideSIPRW is used in the Remote Worker Server Flow (Refer to Section
11.1.10.2). Signaling Interface OutsideSIPRW is used in the Remote Worker Subscriber Flow
(Refer to Section 11.1.10.1), and in the Remote Worker Server Flow (Refer to Section 11.1.10.2).
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11.1.38.

Media Interface

Two new Media interfaces were created for the inside and outside IP interfaces used for Remote

Worker SIP traffic.

From Device Specific Settings on the left-hand menu, select Media Interface. Click on the Add
button to create Media Interface InsideMediaRW using the parameters shown below:

e Media IP =10.10.97.173.
e Port Range = 35000 — 55000.

From Device Specific Settings on the left-hand menu, select Media Interface. Click on the Add
button to create Media Interface OutsideMediaRW using the parameters shown below:

e Media IP =10.10.98.102.
e Port Range = 35000 — 55000.

Dashboars
Adminstration
Bacugp/Restore
System Management
Global Parameters
Globa! Profiles
PPM Servces
Doman Poloes
TLS Managament
4 |Dewnce Spechc Settngs;
Network Management
Media intarface |

Sgnalrg Interface

End Point Flows

Session Border Controller for Enterprise

Media Interface: mSBCE

mSBCE

Methrying or bty o exirborg v aevboe sl fegore e agyicad o et et bedone dekimg eefinct Aggdorion jevtarte oy b et
Trives Sistion Mutuoseen!

Narrw
ImdaMeda
Cunislada
inskdoModaRi'W

QuisizeModaR W

M 1P Pt Rurage
100037 178 35000 - 40002
10.10 52 10¢ 35000 - 40000
104097 173 35300 - 64103
01098 192 35800 - 55003

AVAYA

Media Interface InsideMediaRW is used in the Remote Worker Server Flow (Refer to Section
11.1.10.2). Media Interface OutsideMediaRW is used in the Remote Worker Subscriber Flow
(Refer to Section 11.1.10.1).
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11.1.4. Server Profile for Avaya IP Office

TCP transport protocol (which is required for the Remote Worker connection between the Avaya
SBCE and Avaya IP Office) needs to be added to the existing IPO_14 Server Profile (see Section
6.2.4).

From Global Profiles on the left-hand menu, select Server Configuration
e Select the existing IPO_14 profile and click on Edit.
e On General tab, enter the following:
- IP Address/[FQDNSs: 10.10.98.14 (Avaya IP Office LAN2 interface IP Address).

- Port: 5060.
- Transport: TCP.

Aarrs Incidents Status v Logs v

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IPO_14
Adminstrabon Aad Feoonme Choon Dovom
Bacup/Restore . L ———— : : -
System Management - ) Lessermnionrd! Bherastoverns B lasraaserd |
> = PO 4
Gobal Parameters e Server Type Cal Serv
« [Glcbsl Profiles 8P4
b 1P Addross | FQON Port Traraport
Doman DoS
10103012 5050 UDF
Fingerperst
Server Inteworking 10405814 5050 TCP
Phone inlerworkng Edt
Medka Forang
Roe ﬂl’-]
Server Configuration
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11.1.5. Routing Profiles
Two new Routing Profiles are required to support Remote Worker.

From the menu on the left-hand side, select Global Profiles - Routing and click Add as
highlighted below.

Enter Profile Name: To_IPO_14 RW (not shown).
e URI Group: SP4 (Refer to Section 6.2.3).
Load Balancing: Priority.
Check Next Hop Priority.
Click Add button to add a Next-Hop Address
Priority/Weight: 1.
Server Configuration: IPO_14 (Refer to Section 11.1.4).
Next Hop Address: 10.10.98.14:5060 (TCP) (Avaya IP Office LAN2 interface IP address).
Click Finish to submit the changes.

URI Geoup S 1 Tuvw of Dy e

| Load Balancing NAPTR

p— eaos oty
Nuxt Hap n-Diakg Ignive Rote Heude

Prionty

[ Serear Configuraton Nt Hop Addrass
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From the menu on the left-hand side, select Global Profiles - Routing, select the existing default
Routing Profile and click on the Clone button, and name it default_ RW, then select Next (not
shown). Keep all the default values. Click Finish to submit the changes.

Profile : defaull_NW . Edx Rule
UR! Geoup " Time of Day
Loyd Befancng v NPTR
Transpea Nou v Nast Hop Priadny

Naxt Mop In-Dialog Igrore Route Header

Click the Add button to add a Next-Hop Address

" Finmsh '

The Routing Profile To_IPO_14 RW is used in the Remote Worker Subscriber Flow (Refer to
Section 11.1.10.1). The Routing Profile default RW is used in the Remote Worker Server Flow
(Refer to Section 11.1.10.2).

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 60 of 73
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSAIPO91SBCE63



11.1.6. User Agent

User Agents are created for each type of Remote Worker endpoint used. In the configuration for the
compliance test, the Avaya Communicator for Windows SIP softphone was used, and its
configuration is shown below.

From the menu on the left-hand side, select Global Parameters - User Agents, and click Add
button to create a new User Agent.

e Enter the following:
e Name = Avaya Communicator

e Regular Expression = Avaya Flare Engine.*

In this expression, “Avaya Flare Engine.*” will match any software version listed after the user
agent name.

As Inciderts Sausv Loga~  Deagnosics Uses Seltings «

Session Border Controller for Enterprise AVAYA

Dashboars User Agents
Admunastration

Bacugp/Restore

. User Agants
System Maragament

+ Global Parameters % Add

RADIUS
(oS ' 00aS Avaya Cammunicater Avaya Flare Engloa *
Strubber
User Agents
Global Profiles

The Avaya Communicator User Agent is defined in the Remote Worker Subscriber Flow (Section
11.1.10.2).

11.1.7. Application Rules
Application Rule RW_AR is created for Remote Worker. Use default-trunk rule.
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11.1.8. Media Rules

Two Media Rules are defined. Rule SRTP-RW is defined to enable the use of SRTP between the
Avaya Communicator for Windows Remote Worker (which also uses TLS for transport for user
login; see Section 11.3.1) and the Avaya SBCE. Rule RTP-RW is created for the Remote Worker

connection from the Avaya SBCE to Avaya IP Office.

From the menu on the left-hand side, select Domain Policies > Media Rules

Select the default-low-med and click on the Clone button to create the SRTP-RW rule.

e Enter a name (e.g., SRTP-RW) and click Finish (not shown).

e Edit the created Media Rule to populate the fields in the Media Encryption tab as shown

below. Click Finish to submit the changes.

Media Encryption

Audioc Encryption

||

Preferred Format #1

SRTP_AES_CM_128_HMAC_SHA1_80 ~ l

Preferred Format #2 NONE
Preferred Format #3 NONE
Encrypted RTCP (=]
MKI =]
Lifetime 20

Leave blank to match any valus.

Interworking [*]

Video Encryption

Preferred Format #1 RTP
Preferred Format #2 NONE
Preferred Format #3 NONE

Encrypted RTCP
MKI

Lifetime on

Le=ave blank to match any valus,

Interworking ]

Miscellaneous

Capability Negotiation (]

, |

v

Finish |
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Create the Media Rule RTP-RW from cloning the default-low-med again. The screen below shows
the rule’s Media Encryption tab.

Media Encryption

Audio Encryption

Preferred Format #1 RTP -
Preferred Format #2 MNOMNE -
Preferred Format #3 MNOMNE

Encrypted RTCP

MK

Lifetime a0

Leave blank to match any value.

Interwarking

Video Encryption

Preferred Format #1 RTP -
Preferred Format #2 MNOMNE -
Preferred Format #3 MNOMNE

Encrypted RTCP
MR

Lifetime a0

Leave blank to match any value.

Interworking [

Miscellaneous

Capability Megotiation [

Finish

Media Rule SRTP-RW is assigned to the End Point Policy Group RW-SRTP-PG (Section 11.1.9).
Media Rule RTP-RW is assigned to the End Point Policy Group RW-RTP-PG (Section 11.1.9).
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11.1.9. End Point Policy Groups

Two new End Point Policy Groups are defined for Remote Worker. Group RW-SRTP-PG is
defined for the SRTP connection and RW-RTP-PG is defined for the RTP connection.

From the menu on the left-hand side, select Domain Policies - End Point Policy Groups.
e Select Add button to create a new End Point Policy Group.
e Enter a name (e.g., RW-SRTP-PG), and click on Next (not shown).
e The Policy Group window will open. Enter the information as shown in capture bellow.

| Application Ruks

‘ Barder Rulo
Nadin Flube

!Sar.ml\ Ru

1 Slgnaling Rule

End Point Policy Group RW-RTP-PG is similarly created as shown in capture bellow.

| .
| Appiication Ruks

| Barder Ruse detsul

| Nucha Pk ATP-RV
| Secwty Ruke dotsut-iw Vv
|

| Sipnafing Rusbe detsult

Bock | | i
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End Point Policy Group RW-SRTP-PG is used in the Subscriber Flow (Refer to Section 11.1.10.1).
End Point Policy Group RW-RTP-PG is used in the Server Flow (Refer to Section 11.1.10.2).

11.1.10. End Point Flows
A Subscriber Flow and a Server Flow are created for Remote Worker.

11.1.10.1  Subscriber Flow

A Subscriber Flow is defined as follows:
From the menu on the left-hand side, select Device Specific Settings - End Point Flows.

On Subscriber Flows tab, click on Add and the Criteria window will open.
e Enter Flow Name (e.g., Communicator_RW).
e URI Group = SP4 (Refer to Section 6.2.3).
e User Agent = Avaya Communicator (Refer to Section 11.1.6).
e Source Subnet = * (default).
e Via Host = * (default).
e Contact Host = * (default).
e Signaling Interface = OutsideSIPRW (Refer to Section 11.1.2).

| User Agamt Avays Commanicais v

Sawrta Subnet
e WML U

Via Host
Be avvar e 157 190

Cantact Host
b sem 183

saxar.cem 163 1080 134

[Signating wtorace CAngeSIPaw )|

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 65 of 73
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSAIPO91SBCE63



Click on Next and the Profile window will open. Enter the followings:

Source = Subscriber
Methods Allowed Before REGISTER: Leave as default.

Media Interface = OutsideMediaRW (Refer to Section 11.1.3).
End Point Policy Group = RW-SRTP-PG (Refer to Section 11.1.9).
Routing Profile = To_IPO_14 RW (Refer to Section 11.1.5).
Topology Hiding Profile = None.

Phone Interworking Profile = Avaya-Ru.

TLS Client Profile = AvayaSBCClient.

File Transfer Profile = None.

Signaling Manipulation Script = None.
Click Finish to submit the changes.

Add Flow X

Certain End Point Policy Groups are not available because there are no RADIUS senvers
configured: To use End Point Policy Groups containing Security Rules configured for authentication
please add a RADIUS server.
® Subscriber
Source o s
L) Click To Call
INFO
MESSAGE ™
Methods Allowed Before REGISTER NOTIEY
OPTIONS
Media Interface [OutsideMediaRW ‘|
End Point Policy Group [RW—SRTP-PG v
Routing Profile [To_IPO_14_RW V|
Optional Settings
Topology Hiding Profile lNone VI
Phone Interworking Profile |Avaya-Ru v
TLS Client Profile | AvayaSBCClient V|
File Transfer Profile None Vv
Signaling Manipulation Script [None |
Presence Server Address | |
Ex: domain.com, 192.162.0.101
| Back | || Finish |
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The Subscriber Flows tab shown below displays the finished Subscribe Flow Communicator RW:

ANearmrs

Inciterss

Dashbosd End Point Flows: mSBCE
Administration
Sacian/Restors
Systeen Management
Global Parameters
Global Profiles
PPM Senvices
Doman Paloes
TLS ."f’"r"?':"'cf( = Priadty
4 [Dewioe Spechic Setings;
Network Management !
Meda Imetace
Sgnalng Interface
End Point Flows |

Session Border Controller for Enterprise

Subscilbar Fiows) | | Sarver Flows |

I ockiicaions rroaer b ) Sl ot Flaw il setly Bk i sflect ot sy ssgistystions o (e pyeetation

Communcitor RW

At OvIe W (0w 10 B0l B dascristion

ot Point Policy
Group

Flow Namw Unar Agong

Avoys

g
P4 Commuricator

RW-SRTP-PS

Click on the highlighted View link brings

up the following View Flow window.

View Flow: Communicator RW X

Methods Allowed Before REGISTER
User Agent

Media Interface

End Point Policy Group

Routing Profile

Presence Server Address

- Criteria - Optional Settings
Flow Name Communicator_ RW Topology Hiding Profile None
URI Group SP4 Phone Interworking Profile Avaya-Ru
User Agent Avaya Communicator TLS Client Profile AvayaSBCClient
Source Subnet & RADIUS Profile Neone
Via Host ¥ File Transfer Profile None
Contact Host * Signaling Manipulation Script None
Signaling Interface  OutsideSIPRW
- Profile
Source Subscriber

Avaya Communicator
OutsideMediaRW
RW-SRTP-PG
To_IPO_14 RW
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11.1.10.2  Server Flow
The following section shows the new Server Flow settings for Remote Worker.

From the menu on the left-hand side, select Device Specific Settings = End Point Flows.
On Server Flows tab, click on Add to create a new server flow for Remote Worker.
Enter the following:

e Flow Name =IPO_14 RW

e Server Configuration = IPO_14 (Refer to Section 11.1.4).

e URI Group = * (default).

e Transport = * (default).

e Remote Subnet = * (default).

e Received Interface = OutsideSIPRW (Refer to Section 11.1.2).

e Signaling Interface = InsideSIPRW (Refer to Section 11.1.2).

e Media Interface = InsideMediaRW (Refer to Section 11.1.3).

e End Point Policy Group = RW-RTP-PG (Refer to Section 11.1.9).

e Routing Profile = default_RW (Refer to Section 11.1.5).

e Topology Hiding Profile = None (default).

e File Transfer Profile = None (default).
e Signaling Manipulation Script = None.
e Click Finish to submit the changes.

!Fhu HName

|
iS«vu Corfguraton

|URI Geoup

Transpea
Remtote Subowl

Roceived interface OutndeSIPRW v

Symkng rtertoce InndeSPAW v

Media Interincn Inmdalbedaity W
Esd Poot Pulicy Groug NP0
Routing Profie dotaal_ AW W
Tapslegy Hiding Profie

Fila Teanslar Frofie

Signaling Manipufasion Script

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 68 of 73
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSAIPO91SBCE63



If this Remote Worker server flow is listed ahead of the flow for SIP Trunking (IPO Flow as created
in Section 6.4.4.2), enter 2 in the Priority box at the start of the Remote Worker flow entry and
click the Update button under the server name. The completed flow should show up in the Server

Flows tab as below.

Dashbosd
Adminstration
BackupRestors
System Management
Global Parameters
Global Profiles
PPM Senvices

Session Border Controller for Enterprise

End Point Flows: mSBCE

(Sibacaiar o] <arer o

mSBCE S

THick bt 42 01 5 T dhesd i

r Sarver Configuration: IPO_14
Doman Paloes Usdets |
TLS Management Etud Poinl
4 [Dewie Spechc Setirngs | Srhiny ¥low Name [;:fl" ';:L';":'S Polcy ':,::";LV
Network Management v
Media Imertace 1 PO Flow S5P4  OusideSP NS SIP $0_14  To SP4
R shndos b POMRW  * QUSSR InskdaSIPRW RO ot |
End Point Flows | 3
Sesson Flows
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11.2. Remote Worker Endpoint Configuration on Avaya IP Office

The Remote Worker Avaya Communicator for Windows endpoint is added to the Avaya IP Office
User and Extension configuration.

11.2.1. Extension and User Configuration

No special configurations are required to create the Remote Worker extension and user in Avaya IP
Office. Follow the same standard procedures for creating a local extension and user for Avaya
Communicator for Windows.

The Remote Worker user provisioned is shown below. Note that since the Remote Worker endpoint
used in the reference configuration is Avaya Communicator for Windows, the Enable Softphone
and Enable Communicator options are selected.

Note — Do not check the Enable Remote Worker option. This is only enabled for Avaya IP Office
“native” Remote Worker configurations, not for Remote Worker configurations utilizing the Avaya
SBCE.

POfices || User E 1260- 1260° CEEEN

R OO (¢ Hame [

Vokowmasl | DD Saom Coges | bource Numbers  Talegheny | Fomawdng | Dl Yoce Bacordng | vtton Programmeng | Meny Program

Actount e Erabiiey
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The SIP tab for the Remote User is configured the same way as with local IP Office user (see

Section 5.7).

o ticne

lgPemoterynsge

SO0 ™y 2/

- = >
IP Offices | User |5 1260- 1260° oo X o
o [Ye. Y
& voare m e ShRen Ol In | Votos Recerding  Bumsn Programmng | Mermy frogramming | Mobsey | Gesup Membecivg | Aencuncemerm (49 Bersenal Desstory | W+
i Ogerstor () s 125 h 3
s [ 125 P Name BATAA %0
12 »
' 1360 130 W Daploy Narme (Alum)  BETO00200
[ ST 164
| St % ¢ ATO0S I

SPOC 3/12/2015

_Lo Concal Help
11.2.2. Incoming Call Route
Follow the same procedures described in Section 5.8 for defining an Incoming Call Route to the
Remote Worker.
E 17 64TXXX1260 th-8 X
* || Standard | Velce Recording | [Detmations
NimeSTosde Destination Famack Etenoon |
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11.3. Remote Worker Avaya Communicator for Windows

The following screen illustrates Avaya Communicator for Windows administration settings for
Remote Worker as used in the reference configuration.

11.3.1. Settings — Server Screen

After opening the Avaya Communicator for Windows application, select the Settings icon, select
Server from the Settings menu, and enter the following:
e Server address = 10.10.98.102 (IP address of Remote Worker outside interface B1 on
Avaya SBCE (see Section 11.1.1).

e Server port = 5061.
e Transport type = TLS.

e Domain =10.10.98.14 (Domain name was defined in LAN2-> VoIP tab in Section 5.1).

e Click OK the save the changes.

A Avaya Communicator

Not logged in

A Settings

Server

Server address

10.10.98.102

Dialing Rules
Enterprise Search
Contacts

Audio

Video

Conference
Language
Window

About

Support

Server port

5061

Transport type TLS TCP
Domain 10.10.98.14
Presence server address

oK Cancel

Note: - For this compliance testing, only audio calls were tested with SRTP media encryption (see
Section 11.1.8) for Avaya Communicator for Windows.
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